The information in this document is subject to change without notice and does not represent a commitment on the part of Native Instruments GmbH. The software described by this document is subject to a License Agreement and may not be copied to other media. No part of this publication may be copied, reproduced or otherwise transmitted or recorded, for any purpose, without prior written permission by Native Instruments GmbH, hereinafter referred to as Native Instruments.

“Native Instruments”, “NI” and associated logos are (registered) trademarks of Native Instruments GmbH.

Mac, Mac OS, GarageBand, Logic, iTunes and iPod are registered trademarks of Apple Inc., registered in the U.S. and other countries.

Windows, Windows Vista and DirectSound are registered trademarks of Microsoft Corporation in the United States and/or other countries.

All other trade marks are the property of their respective owners and use of them does not imply any affiliation with or endorsement by them.

Document authored by: Jeffrey Fisher

Document version: 1.0 (06/2011)

Special thanks to the Beta Test Team, who were invaluable not just in tracking down bugs, but in making this a better product.
Germany
Native Instruments GmbH
Schlesische Str. 29-30
D-10997 Berlin
Germany
www.native-instruments.de

USA
Native Instruments North America, Inc.
6725 Sunset Boulevard
5th Floor
Los Angeles, CA 90028
USA
www.native-instruments.com

© Native Instruments GmbH, 2011. All rights reserved.
# Table of Contents

1 **Introduction** .......................................................................................................................... 7  
   1.1 About this Manual .................................................................................................................. 7  
   1.2 Safety Considerations .......................................................................................................... 8  
2 **User Interface** .......................................................................................................................... 9  
   2.1 Global Header ....................................................................................................................... 9  
      2.1.1 Input and Output ............................................................................................................ 10  
      2.1.2 System Performance ........................................................................................................ 10  
   2.2 Live View ............................................................................................................................. 12  
   2.3 Toolbar and Rack .................................................................................................................... 13  
   2.4 Virtual Rig Kontrol ............................................................................................................... 15  
   2.5 SideKick ................................................................................................................................ 16  
3 **Components and the Rack** ...................................................................................................... 19  
   3.1 Building a Rack from Scratch ............................................................................................... 19  
      3.1.1 The Component Pool ........................................................................................................ 20  
      3.1.2 Setting Up an Amp .......................................................................................................... 20  
      3.1.3 Basics for Rack Building .................................................................................................. 22  
4 **Working with Presets** ............................................................................................................. 25  
   4.1 The Preset Browser ............................................................................................................... 26  
      4.1.1 Tags and the Preset List ..................................................................................................... 27  
      4.1.2 The Search Engine .......................................................................................................... 28  
      4.1.3 Loading and Saving Rack Presets .................................................................................... 29  
      4.1.4 Importing Presets ............................................................................................................ 29  
      4.1.5 Exporting Presets ............................................................................................................ 30  
      4.1.6 Saving New Rack Presets ............................................................................................... 30  
      4.1.7 Tags on Three Levels ....................................................................................................... 32  
      4.1.8 Tagging Presets ............................................................................................................... 33
<table>
<thead>
<tr>
<th>Section</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.2</td>
<td>Preset Info Page</td>
<td>35</td>
</tr>
<tr>
<td>4.3</td>
<td>Component Presets</td>
<td>36</td>
</tr>
<tr>
<td>4.3.1</td>
<td>Basics</td>
<td>36</td>
</tr>
<tr>
<td>5</td>
<td>The Rack Tools</td>
<td>41</td>
</tr>
<tr>
<td>5.1</td>
<td>Tapedeck Pre</td>
<td>41</td>
</tr>
<tr>
<td>5.1.1</td>
<td>Playback</td>
<td>41</td>
</tr>
<tr>
<td>5.1.2</td>
<td>Recording</td>
<td>42</td>
</tr>
<tr>
<td>5.2</td>
<td>Tapedeck Post</td>
<td>42</td>
</tr>
<tr>
<td>5.2.1</td>
<td>Interaction with Tapedeck Pre</td>
<td>43</td>
</tr>
<tr>
<td>5.2.2</td>
<td>Recording Overdubs</td>
<td>43</td>
</tr>
<tr>
<td>5.3</td>
<td>Tuner</td>
<td>44</td>
</tr>
<tr>
<td>5.4</td>
<td>Metronome and Synchronization</td>
<td>45</td>
</tr>
<tr>
<td>5.5</td>
<td>Preset Volume</td>
<td>46</td>
</tr>
<tr>
<td>5.6</td>
<td>Master FX</td>
<td>47</td>
</tr>
<tr>
<td>6</td>
<td>The Rig Kontrol</td>
<td>49</td>
</tr>
<tr>
<td>6.1</td>
<td>Activating the Rig Kontrol</td>
<td>49</td>
</tr>
<tr>
<td>6.2</td>
<td>Assigning Functions to the Rig Kontrol</td>
<td>50</td>
</tr>
<tr>
<td>6.3</td>
<td>Configuring Assignments</td>
<td>51</td>
</tr>
<tr>
<td>6.4</td>
<td>Assigning Functions to External Controllers</td>
<td>53</td>
</tr>
<tr>
<td>7</td>
<td>Using Guitar Rig in a Host</td>
<td>54</td>
</tr>
<tr>
<td>7.1</td>
<td>Basics</td>
<td>54</td>
</tr>
<tr>
<td>7.1.1</td>
<td>Audio and MIDI Setup</td>
<td>54</td>
</tr>
<tr>
<td>7.1.2</td>
<td>Plug-In Location</td>
<td>54</td>
</tr>
<tr>
<td>7.1.3</td>
<td>Setting Up a Guitar or Bass Track</td>
<td>54</td>
</tr>
<tr>
<td>7.1.4</td>
<td>Synchronization</td>
<td>55</td>
</tr>
<tr>
<td>7.1.5</td>
<td>Total Recall</td>
<td>55</td>
</tr>
<tr>
<td>7.2</td>
<td>Automating Parameters</td>
<td>55</td>
</tr>
<tr>
<td>7.2.1</td>
<td>The Automation List</td>
<td>55</td>
</tr>
<tr>
<td>Section</td>
<td>Title</td>
<td>Page</td>
</tr>
<tr>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>7.2.2</td>
<td>Automating Parameters in Apple Logic Pro</td>
<td>56</td>
</tr>
<tr>
<td>7.3</td>
<td>Sidechaining</td>
<td>57</td>
</tr>
<tr>
<td><strong>8</strong></td>
<td>Options</td>
<td>58</td>
</tr>
<tr>
<td>8.1</td>
<td>Controller</td>
<td>58</td>
</tr>
<tr>
<td>8.1.1</td>
<td>Setting up External MIDI Controllers</td>
<td>59</td>
</tr>
<tr>
<td>8.1.2</td>
<td>Assigning Functions to Controllers</td>
<td>60</td>
</tr>
<tr>
<td>8.1.3</td>
<td>Linking External MIDI Controllers to the Virtual Rig Kontrol</td>
<td>62</td>
</tr>
<tr>
<td>8.1.4</td>
<td>Hold Mode for MIDI Controllers and Rig Kontrol</td>
<td>62</td>
</tr>
<tr>
<td>8.2</td>
<td>Preferences</td>
<td>64</td>
</tr>
<tr>
<td>8.2.1</td>
<td>Rig Kontrol 1 Support</td>
<td>66</td>
</tr>
<tr>
<td><strong>9</strong></td>
<td>Menu Bar</td>
<td>68</td>
</tr>
<tr>
<td>9.1</td>
<td>File</td>
<td>68</td>
</tr>
<tr>
<td>9.2</td>
<td>Edit</td>
<td>69</td>
</tr>
<tr>
<td>9.3</td>
<td>View</td>
<td>69</td>
</tr>
<tr>
<td>9.4</td>
<td>Help</td>
<td>70</td>
</tr>
<tr>
<td><strong>10</strong></td>
<td>Audio and MIDI Settings</td>
<td>71</td>
</tr>
<tr>
<td>10.1</td>
<td>Audio</td>
<td>71</td>
</tr>
<tr>
<td><strong>11</strong></td>
<td>Keyboard Shortcuts</td>
<td>74</td>
</tr>
</tbody>
</table>


1 Introduction

Welcome to the GUITAR RIG 5 Application Reference!

1.1 About this Manual

This manual covers all elements of GUITAR RIG 5 in detail. If you want to get deeply into the software, this is the document to refer to.

The following documents are also available:

- The Setup Guide tells you how to install, activate and configure GUITAR RIG 5 on your system.
- The Getting Started guide provides you with essential information needed to use GUITAR RIG 5 and explains how to accomplish fundamental tasks.
- To learn about each and every knob that controls the amps, distortion pedals and other components for shaping and modulating GUITAR RIG's sounds, refer to the Components Reference.
- If you have obtained GUITAR RIG 5 in a hardware bundle, please read the according Hardware Reference to learn more about how to set up and use the RIG KONTROL 3.

All the manuals can be accessed through the program menu by selecting Help > Open Manual.

Visit the community forums at http://www.native-instruments.com/forum, where beginners and experienced users exchange knowledge on Native Instruments products every day.

Document Conventions

This document uses particular formatting to point out special facts and to warn you of potential issues. The icons introducing the following notes let you see what kind of information can be expected:

![Exclamation Mark Icon]
Whenever this exclamation mark icon appears, you should read the corresponding note carefully and follow the instructions and hints given there if applicable.

![Light Bulb Icon]
This light bulb icon indicates that a note contains useful extra information. This information may often help you to solve a task more efficiently, but does not necessarily apply to the set-up or operating system you are using; however, it's always worth a look.

Furthermore, the following formatting is used:
- Text appearing in (drop-down) menus (such as Open..., Save as... etc.) and paths to locations on your hard drive or other storage devices is printed in *italics*.
- Text appearing elsewhere on the screen (labels of buttons, controls, text next to checkboxes etc.) is printed in **light blue**. Whenever you see this formatting applied, you will find the same text appearing on the screen.
- Important names and concepts are printed in **bold**.
- References to keys on your computer's keyboard you'll find put in square brackets (e.g., "Press [Shift] + [Return]").

▶ Single instructions are introduced by this play button type arrow.
→ Results of actions are introduced by this smaller arrow.

## 1.2 Safety Considerations

GUITAR RIG 5 — in combination with headphones or amplifier-driven speakers — produces output levels that can cause hearing damage. For your protection, set all output levels to a minimum before using GUITAR RIG 5. Gradually raise the volume controls while music is playing to set the desired listening level. If you experience any hearing problems or persistent ringing in the ears, consult an audiologist immediately.
2 User Interface

Learn everything about the GUITAR RIG 5 user interface in the following sections.

The user interface of GUITAR RIG in Standard View

2.1 Global Header

The Global Header (visible both in Standard view and in Live view) assembles the main input and output controls as well as the system performance display of GUITAR RIG 5.

GUITAR RIG Global Header
Apart from these, the **LIVE** button is situated in the Global Header. It activates Live view, which has been optimized for on-stage use — see section ↑2.2, Live View for more information.

### 2.1.1 Input and Output

From left to right, the following global input and output controls are available:

- **The L/R buttons** control the input routing of the software. By default, both input channels are processed. When one channel is deactivated (the light will turn off by clicking on its button), the other’s (mono) signal is routed to both of GUITAR RIG’s stereo channels. This is recommended if you are processing a single guitar or bass.

- **The Input Meter (IN)** shows the amplitude of the incoming signal and features an integrated volume fader that controls the input level of the software. It should be adjusted so that the Input Meter gets close to but never hits the red zone that indicates overload.

- **The Gate button** operates a basic noise gate that reduces hiss when you are not playing. Turn it on or off by clicking the button; adjust the threshold to your actual residual noise level with the knob to the right.

- **The Learn function** automatically sets the optimum threshold. Double click the threshold knob and do not play your instrument for some seconds: GUITAR RIG 5 analyses your signal and sets the threshold just above any residual noise.

- **The Output Meter (OUT)** shows the amplitude of the software’s output and features an integrated volume fader that controls the output level. It should be adjusted so that the limiter is never triggered, indicated by the Output Meter hitting the orange zone.

- **The Limiter (labeled Limit)** prevents the output level from reaching distorted and possibly harmful volume peaks. You may turn it off by clicking on the button; distortion will then be indicated by red LEDs.

### 2.1.2 System Performance

The rightmost section shows information about your system’s performance:

- Your **CPU load** is constantly measured — it should not go above 70% to avoid clicks and interruptions.

- If it is necessary to save some **CPU power** without limiting the number of components, you can deactivate High Quality mode by clicking on the **HI** button. High Quality mode means that the current sample rate is doubled using oversampling, resulting in a higher resolution of sound.
- Clicking on the Power button completely bypasses the sound processing of GUITAR RIG 5, changing the CPU display to **BYP**.
- When no audio driver is selected, the CPU display shows **OFF**.
- If a CPU overload occurs, the display shows **OVER** and the Power button turns red — the audio engine has been disabled. You might need to disable some components or turn off high quality mode to save CPU power. Then re-activate the audio engine by clicking the Power button.
2.2 Live View

Clicking on the *LIVE* button in the Global Header or pressing [F1] switches from the Standard view to the Live view. It hides the Rack and instead puts the most important performance features into a clear layout. The Live view is perfect for on-stage use, consolidating the following elements:

- Global Header
- Current Preset List as defined in the Preset Browser
- Currently selected preset with information
- Metronome, Tuner, and Loop Machine (optional)
- Large Virtual Rig Kontrol display with all assignments

**Metronome, Tuner and Loop Machine**

You can activate these Live view options by clicking on the buttons labeled **METRONOME, TUNER** and **LOOP MACHINE**. Whenever you trigger the Tuner via a controller input, the Tuner will automatically be activated.

**2.3 Toolbar and Rack**

If you are in Live view, please return to Standard view by clicking on the **LIVE** button to continue our tour through the user interface of GUITAR RIG 5.
The Rack with Tools and Virtual Rig Kontrol

The Toolbar sits on top of the Rack and is your one-stop-shop for all the Rack Tools and some other frequently used features.

- The left-most box shows the currently activated Rack preset. You can step through the current Preset List, even if it is not visible, by clicking on the Up/Down arrows.
- Save makes changes to the loaded preset permanent, overriding the stored settings with the current ones. Factory Presets and User Presets are now stored in separate folders.
- **Save as** creates a new preset with the current settings. After clicking Save as, you are presented with the Save As page in the SideKick, where you can enter a name, author, rating and notes to save with the preset. It will be saved with all the tags that are currently selected in the upper part of the Preset Browser, unless you change them before you press Save to confirm.

- The middle buttons toggle the display of the Virtual Rig Kontrol (see section *2.4, Virtual Rig Kontrol*) and all the Rack Tools: Tapedeck Pre; Tapedeck Post; Tuner, Metronome; PRST (Preset Volume); and MSTR FX (Master FX). See section *5, The Rack Tools* for details on the Rack Tools.

- On the right side, the x (cross) will empty the rack of all components with one click — this can of course be undone by selecting *Edit > Undo* from the program menu or by pressing [Ctrl]+[Z] (Win) / [Cmd]+[Z] (Mac OS X).

- Clicking on the - (minus) minimizes all rack modules. It then turns into a + (plus), allowing to restore the previous view.

The Rack holds all the components that are processing your sound — giving a clear overview of the signal flow. It is the heart of GUITAR RIG 5’s functionality, and is incredibly easy to use. See section *3, Components and the Rack* for all details.

### 2.4 Virtual Rig Kontrol

The Virtual Rig Kontrol is shown after clicking on its button in the Toolbar or by pressing F3. It is a graphical representation of the Rig Kontrol foot controller, indicating which functions are assigned to its buttons and the foot pedal. See section *6, The Rig Kontrol* for a full explanation.
The buttons and the foot pedal can also be operated directly with the mouse if no Rig Kontrol is connected. Even if you are not using the Rig Kontrol, you can assign external MIDI controllers to the Virtual Rig Kontrol to benefit from its integration, especially in Live view. See section 8.1.3, Linking External MIDI Controllers to the Virtual Rig Kontrol for details.

2.5 SideKick
About a third of the user interface is occupied by the SideKick, a multi-functional area on the left hand side of the screen.
The Sidekick in three different modes

Sidekick displays different content depending on which of the tab buttons (Browser, Components or Options) is activated. The SideKick can be hidden by clicking on the Arrow button situated next to the tab buttons, or by pressing F2.

- The Preset Browser (1) allows filtering of all available Rack Presets on three levels; you can organize your presets and perform a text search to easily find your presets. See section 13, Components and the Rack on working with presets.
- The Component Pool (2) contains all available components. Complete explanation of each component can be found in the Components Reference. See section ↑3, Components and the Rack on techniques to build up your rack.
- The Options screen (3) serves to configure external controllers and their assignments, as well as preferences such as the window height, the path to presets, and other details. See section ↑8, Options on setting up MIDI controllers and other options.
3 Components and the Rack

3.1 Building a Rack from Scratch

On the first start, the Rack of GUITAR RIG 5 is empty. You will hear dry, slightly pre-amplified guitar sound when you play: an invitation to try out the various components for yourself.
On future starts, the software will always retain the last state of the Rack before you closed it. Click on the x (cross) in the Toolbar if you want to start from scratch again.

### 3.1.1 The Component Pool

Open the Component Pool by clicking on Components in the SideKick. Categories contains all sound-shaping and modulating components and their Component Presets, ordered alphabetically. Click on their label to see the available components listed below.

- **Amplifiers**: Guitar and bass amps
- **Cabinets**: Matched cabinets, Cabinets & Mics, Control Room, and Control Room Pro
- **Delay & Echo**: Delays and Echo units
- **Distortion**: Distortion, Overdrive and Fuzz pedals
- **Dynamics**: Compressors, Limiters and Gates
- **Equalizer**: Graphic Equalizers
- **Filters**: Filters and wah-wah pedals
- **Modifiers**: Programmable parameter modifiers
- **Modulation**: Time- and pitch-based modulation effects
- **Pitch**: Pitched based effects and synthesizers
- **Reverbs**: Reverbs
- **Special FX**: Hard to categorize special effects
- **Tools**: Loop, Master FX, Container and tools for parallel signal processing

When you select any component by clicking on it, it is highlighted, and a list of all available Component Presets is shown below. Learn more about Component Presets in section 4.3, Component Presets.

### 3.1.2 Setting Up an Amp

The fastest way to start designing sounds with GUITAR RIG 5 is by adding an amp to the Rack. If you want to quickly create a guitar sound, try the Jump amplifier.

- Drag the amp’s icon from the Component Pool to the Rack. You can also double click the icon.

The amplifier and a Matched Cabinet will be inserted into the Rack simultaneously. The Matched Cabinet is only added automatically if no cabinet is present below the destination of the amp. If you play now, you will hear that famous British sound.
To change the cabinet, click on it once to highlight the component in the Rack. Then go to the Component Pool, section Cabinets. Here you will see four options: Cabinets & Mics, Control Room, Control Room Pro, and Matched Cabinets. Another option is to use the pull down menu included in the matched cabinet. Here you will see the full list of available cabinets. You can also use the plus/minus tabs to toggle through the list.
Dragging from the Component Pool will replace the Matched Cabinet (highlighted) in the Rack

- All the knobs and switches you see are controlling the amp’s sound. Clicking with the mouse flips the switches, clicking and dragging the mouse up and down (while holding the mouse button down) turns the knobs.
- If you want to check out some amp settings recommended by our sound designers, try the pull down menu to configure the Jump. Click on the arrow to display the Component Presets.

Component Presets

3.1.3 Basics for Rack Building
The audio signal runs through the chain of rack modules from top to bottom, except if you are using special tools that create parallel processing paths, like the Split. See the Components Reference for details on these tools.
Rack Usage

- You can add components to the Rack by dragging them from the Component Pool and dropping them into any position you want. You can also add the component pre-configured to produce a particular sound, by dragging a Component Preset into the Rack (see section 4.3, Component Presets).
- Clicking on any component in the Rack selects it, indicated by a surrounding orange frame. At the same time, the associated page and item in the Component Pool is displayed. Thus, while building up your rack, you are always shown the most probable alternatives to your selection.

Hotswapping

While a component is highlighted, double-clicking on any item in the Component Pool or any Component Preset replaces the selected component. This is called hot swapping and allows for quickly trying out alternatives. (Be warned that clicking any component in the Pool will replace that in the rack. For instance, double clicking an effect will replace an amplifier.)

If no component is highlighted, double-clicking on any item of the Component Pool or any Component Preset adds the component to the end of the Rack. It is then immediately selected and ready for hot swapping with another component.

Hot swapping is also possible when dragging a component or Component Preset into the Rack: Just drop it directly onto the component you want to replace, which is indicated by a solid orange rectangle highlighting the destination.
- If you don’t want to replace another component when using Drag & Drop, make sure you drop it beneath the other components, which is indicated by an orange line instead of the rectangle.
Drag and drop: The yellow line indicates where the component will be placed after releasing the mouse button

- Rack Tools (Tuner etc.) have a fixed position and cannot be moved or deleted, but they can be hidden using the Toolbar.
- You can remove Components from the rack by highlighting them and pressing [Del] (Win) / [Cmd]+[Backspace] (Mac OS X), or by dragging and dropping them anywhere outside of the rack. Another option is to choose *Delete selected* from the context menu, after right-clicking the component.

**The Rack Module Column**
All modules in the rack feature a small column on the right:

- The On/Off button allows for true bypassing of the module — no CPU power is consumed when it is turned off.
- The - (Minus) button minimizes the module’s display.
- The triangular arrow toggles its expert panel, if available.
4 Working with Presets

GUITAR RIG 5 would only be half as useful without a sophisticated management system to help you find and organize all available presets. A tag-based Preset Browser and a powerful search function make navigating through presets and managing them a joy. At this point, it is important to understand that there are two different kinds of presets in GUITAR RIG 5:

Rack Presets
Rack Presets allow you to store and recall complete Rack setups and organize them in a convenient way using the Preset Browser. Each Rack Preset consists of a chain of components that is loaded into the Rack when the preset is activated. At the same time, it preserves the tempo and all controller assignments. These can be overridden once the preset is loaded. This depends on the following settings:

- The Metronome’s Sync control is set to Ext or Free: This prevents the Metronome’s tempo to change when loading a preset. Set it to Sound if you want the tempo setting to be loaded with the Rack Preset.
- The assignments of the Virtual Rig Kontrol and other controllers can be globally locked (see section ↑6.2, Assigning Functions to the Rig Kontrol and ↑8.1.2, Assigning Functions to Controllers), which is indicated by a small padlock symbol. These will not be affected by controller assignments stored in a Rack Preset.

GUITAR RIG 5 ships with a huge amount of Rack Presets of any style, and you can easily create more as you see fit.

Component Presets
A Component Preset contains all settings for a single component, such as the exact knob positions of an amp producing your favorite crunch tone. After highlighting one of the items in the Component Pool, all its available presets are shown in a list below. Use Component Presets to store and recall your favorite delay setting or try a special amp sound in another rack’s context. As Component Presets are another tool for building your Rack, details are given in section ↑4.3, Component Presets.
4.1 The Preset Browser

Click on the Browser button to open the Preset Browser — a powerful tool for finding and organizing all your Rack Presets.
4.1.1 Tags and the Preset List

Three columns with several tags, entitled Preset Attributes, define which presets are
shown in the Preset List below. You can select and deselect tags by clicking on them
once. If no tag is highlighted (orange), all available presets are shown.

► Click on a tag in the left column to select it: The Preset List is instantly reduced to the
presets containing this tag.
  ▪ If the tag you chose contains sub-tags, they can be selected in the middle column.
  ▪ Sub-tags of the third level appear in the right column, if present.
  ▪ Consequently, sub-tags disappear if you deselect the tag they belong to by clicking on
    it.
  ▪ You can select multiple tags by holding SHIFT or [Ctrl] while you click.

The Preset List itself sports 3 columns: List Number (#), Name and Rating. Note that you
can resize the height of the list by dragging the resize handle just below the search bar.
Clicking on the column headers will sort by the according values, first ascending then de-
scending.
Preset List and Ratings

The Rating system is very helpful for keeping order in your growing archive: Give your presets a quality rating from 1-5 stars by clicking on one of the 5 dots right beside its name. It will instantly be stored with the preset, to help your memory and — after doing this with all your presets — provide you with a powerful Preset List: Sort it by rating!

4.1.2 The Search Engine

The new search engine will help you to quickly find a particular preset by entering part of its name. The search bar, situated between the Preset Browser and the Preset List, is always ready to process your requests.
Preset Search

With every letter you type in, the search will narrow down the Preset List below by showing presets that contain the string you entered. Clicking on the x (Cross) clears the search bar.

4.1.3 Loading and Saving Rack Presets

Loading Rack Presets from the Preset List is simple: just double-click on the name of the preset you want to load. If you press ALT while doing so, all the components’ Stereo buttons will engage regardless of their stored settings so your complete Rack will process audio in true stereo.

Any changes you make now won’t automatically save to the preset. If you want them to be permanent, click on Save or Save as... above the Rack or at the bottom of the SideKick.

4.1.4 Importing Presets

There are two ways of importing presets into GUITAR RIG 5 — either of them can be the most convenient way to go:
When you drag and drop preset files into the Preset Browser, they will be copied to the Sounds folder of GUITAR RIG 5 and get the tag(s) that were selected before.

After selecting *File > Import* from the GUITAR RIG 5 menu, you can copy presets to the Sounds folder complete with tags. The same happens when you copy files to the Sounds folder manually and click on *Scan Presets* on the Options / Preferences page.

### 4.1.5 Exporting Presets

Aside from simply copying preset files directly from the preset directory, there’s a convenient way of exporting presets directly from the Preset Browser:

1. Make sure the presets you want to export are visible in the Preset List by selecting the right tags in the Browser.

2. Select them by clicking while holding the [Ctrl] (Win) or [Cmd] (Mac OS X) key, pressing [Ctrl] / [Cmd] + [A] selects all presets in the list. Selecting all the presets in the list which are currently not selected is possible by pressing [Ctrl] / [Cmd] + [I] (invert).

3. Copy the presets to the clipboard, i.e. by pressing [Ctrl] / [Cmd] + [C].

4. Paste them anywhere in the Windows Explorer or Finder, simply by selecting the destination folder and pressing [Ctrl] / [Cmd] + [V], and you’re done!

### 4.1.6 Saving New Rack Presets

If you want to save your current rack to a new preset, click on *Save as*. You are now presented with a special page in the SideKick where you can enter the preset’s name, author, rating and some notes to save with it. The new preset will be saved in the Sounds folder.
Saving new presets

The preset will be saved with all tags that are currently selected in the upper part of the Preset Browser. You can still change them on the Save As page, before you press Save again to confirm. User saved presets are marked with a user icon inside the preset lists. Custom presets can be spotted in GUITAR RIG 5 by just looking at the preset lists. To delete a preset, right-click (ctrl-click) on it in the Preset List and select Remove from disk.
4.1.7 Tags on Three Levels
The tags under Preset Attributes are hierarchic, getting more precise from left to right. Each tag of the first and second level can contain sub-tags that further narrow down what you are looking for.

Creating and Deleting Tags
You can create and relate tags to organize your presets exactly as you want. As each preset can appear under multiple tags of different levels, you have a lot of organizational power at hand. Use tags to characterize and group your sounds on up to three levels. Order them by musical genres, pickup types, or to create set-lists for live use.

- Tags can be created by double-clicking into an empty field or by right-clicking into a column and selecting Create a new tag.
- Tags in the second and third column can be created only if a tag is selected left of them — they are sub-tags to the ones on the higher level.

Creating a Tag

➢ To delete a tag, click on it so that it is highlighted in orange (selected). Then right-click anywhere in the Preset Browser. Select Delete this tag to delete the selected tag and all of its sub-tags.

- No preset will be harmed by deleting a tag — all presets are still in the Preset List when no tag is selected.

➢ To delete a preset, right-click on it in the Preset List and select Remove from disk.
Example

Let us create an exemplary three-level tag that you could add to all the presets you are currently preparing to use on stage with your band: “Your Band — Live-Presets — In Progress.”:

1. Create a new tag simply by double-clicking on an empty field in the first column. Type in a text label (e.g. your band name) and press [Enter].
2. Click on the newly created tag to select it — it must be highlighted in orange. Double-click into the middle column and create a new tag (e.g. “Live-Presets”). This is your first sub-tag; another useful one could be “Studio-Presets.”
3. Sub-tags are only visible in relation to their higher-level tags. If you deselect “Your Band” on the first level by clicking on it again, all of its sub-tags are no longer visible.
4. Creating a sub-tag on the third level works exactly the same way, just highlight “Live-Presets” and create a new tag called “In Progress” in the right-most column.

4.1.8 Tagging Presets

Any preset can carry an unlimited number of tags! Adding tags to presets works simply with drag and drop:

- Click on one of the presets in the Preset List and drag it onto one of the tags in the left column of the Preset Browser.
- While dragging and holding down the mouse button, you can navigate through sub-tags to further specify the precise tag you want to add. The moment you release the mouse button to drop the preset on a tag (no matter on which level), the tag is added to the preset.

![Preset Attributes](image.png)

- Because of the hierarchical structure of the tagging system, adding a sub-tag automatically adds its higher-level tag(s) to the preset.
- Drag and drop adds new tags to the preset without deleting the previous ones: The preset will be listed both under the tag that was activated before you dragged it, and under the new tag.
- To remove the currently selected tag from a preset, just delete the entry from the Preset List below. Make sure the correct tag (with sub-tags) is selected, click on the preset in the Preset List, and press DEL (Win) / [Cmd]+BACKSPACE (Mac OS X). Or right-click and select Remove from this list.
- An easy way to remove a preset from many Preset Lists is to use the Info Page (see section 4.2, Preset Info Page).
- After removing all tags from a preset, it is still available in the Preset Browser when you de-select all tags.
- To really delete a preset, highlight it, right-click and select Remove from disk.
4.2 Preset Info Page

After clicking on Info, the following information is shown for the currently selected preset.

Preset Attributes

All the fields can be edited after clicking into the field beneath the label once.

- **Author**: The last name you entered in the Save as dialogue will be used as default.
- **Rating**: Click on the dots / stars to change the rating.
- **Notes**: These will be shown in Live view — a good place for your cheat slip!
- **Preset Attributes**: This shows all tags stored with the currently selected preset at a glance. After selecting one of the tags, the Preset List will change showing all the presets containing this tag. Deleting a preset from the Preset List will remove the currently selected tag from it.
4.3 **Component Presets**
GUITAR RIG 5 comes with plenty of factory presets for components, providing a timesaving alternative to dialing in classic sounds for each component by hand.

4.3.1 **Basics**
A Component Preset contains the settings for a single component. After selecting an item of the Component Pool, press the Presets tab: a list of available Component Presets is displayed below in the SideKick.
The Component Pool, showing the Amplifiers section

The entries of this list have settings that are already adjusted to create a particular sound. To add a component readily configured, you can double-click or even drag and drop a Component Preset anywhere into the Rack.

**Component Presets and the Rack**

Each rack module displays the name of its current Component Preset in a small box on its left hand side, the Component Preset Display.
Component Preset selection

Double-clicking the Component Preset in the SideKick has the same effect as double-clicking a basic component, depending on the state of the Rack:

- If no rack module is highlighted, the component will be added to the end of the rack with the stored settings.
- If a component is highlighted, it will be replaced with the new, pre-configured component.
- If the same component is highlighted in the rack, its settings will be updated with the Component Preset. This is useful if you quickly want to check out different settings of a component in the context of your current rack.

**Saving Component Presets**

Once you have found a good setting for a component you use regularly, you will want to save your own Component Preset. To do this you will want to create a Bank. The Banks are user-defined categories where Component presets are stored.
In the Sidekick preset window is the pull down window where Add Bank can be selected. (From this window Delete Bank and Rename Bank can also be chosen). This will create a new folder in the list of Component Presets.

Type a name of the new folder for saving your Component Presets.
From the component pull down menu choose Save as
→ The new preset will be titled New Preset until a title is chosen.
To save any changes to the preset currently displayed, select Save from the component menu.
Deleting or renaming a Component Preset.

- To delete or rename a Component Preset, right-click on its name in the list and choose from the context menu accordingly.

**Sorting and Rating**

By clicking on the column headers of the list of Component Presets, you can sort it by List Number (#), Name, and Rating. Save a quality rating with each preset by clicking on one of the 5 stars right beside its name. This can always be changed later.
5  The Rack Tools

The following sections will introduce you to the Rack Tools of GUITAR RIG 5: Tapedeck Pre and Post, Tuner and Metronome.

5.1  Tapedeck Pre

The Tapedeck Pre Rack Tool

Tapedeck Pre is the tool for playing back and recording audio at the beginning of GUITAR RIG’s signal chain (except when PLAY AT OUTPUT is activated). Thus, the Tapedeck Pre picks up the dry, unprocessed sound, enabling you to change the sound of your recording later. Playing a file back in Tapedeck Pre sends it through all modules currently in the Rack. Tapedeck Pre is capable of changing your tempo during playback without changing pitch and vice versa. This is great for learning licks by slowing them down, or changing the tempo on backing loops.

5.1.1  Playback

- The easiest way to load sound files into the Tapedeck is to drag and drop them directly onto the component. To browse through your files, click on the Load button (the open folder symbol).
- The Tapedecks can play WAV, AIFF and MP3 files up to a resolution of 16bit.
- Click on the Play button to start playback from the current position of the Transport slider. Click on the Stop button to stop playback.
- If PLAY AT OUTPUT is activated, the sound will not be processed, but directly played in front of the Tapedeck Post, which allows for overdubbing (explained below).
- Adjust the Volume fader to set the playback level. If the Limiter LED lights up, reduce the volume to avoid overload.

You can create a loop to repeat a certain portion of the file over and over:
If the Loop button (right to the Stop button) is pressed, playback will be looped.

- The starting and ending points of the loop are defined by the Start and Stop sliders above the Transport slider, which can be dragged with the mouse.
- Alternatively, you can set these points “on the fly” by pressing the In and Out buttons during playback. The In button sets the start point while the Out button sets the end point of the loop.

There are some controls providing special playback options which can be very useful for practicing, or when using backing tracks:

- Transpose (TRANSP) transposes pitch from 12 semitones to +12 semitones.
- TUNE allows fine-tuning over the range of −50 cents to +50 cents.
- TEMPO will change the playback speed from 50% of the original tempo to 150% of the original tempo.

### 5.1.2 Recording

- If no other file is loaded, click on the Record button to activate it — pressing the Play button now will start recording.
- To initialize a new file to be recorded, click on the New (Page) button in the lower left. This will automatically activate the Record button.
- Click on the Play button and begin recording.
- To save a file after recording, click on the Disk button. Navigate to the folder where you want to save the file. Name the file, and click on the Save button.

### 5.2 Tapedeck Post

![The Tapedeck Post Rack Tool](image)

Tapedeck Post is the tool for playing back and recording audio at the end of GUITAR RIG’s signal chain. Recording your guitar will pick up the processed sound, just as you hear it at the output. Use Tapedeck Post if you want to record your guitar part with the actual
sound, e.g. for using it "outside of" GUITAR RIG 5. Files you import and play back will not be processed, which makes Tapedeck Post ideal for playing drum loops and your own backing tracks.

Its controls are similar to Tapedeck Pre, except that it has no Transpose (TRANSPOSE), TUNE or TEMPO controls, nor can you choose between playing at Input or at Output.

5.2.1 Interaction with Tapedeck Pre

Tapedeck Post is linked with Tapedeck Pre to allow for synchronization and easy transferal of recordings.

- When SYNC DECKS is turned on, the Tapedeck Post starts and stops simultaneously with the Tapedeck Pre. This is useful when processing samples with GUITAR RIG, as their timing is kept intact.
- You can easily transfer a recording from Tapedeck Post to Tapedeck Pre by clicking on the TRANSFER button.

5.2.2 Recording Overdubs

1. As Tapedeck Pre can play its file at the end of the signal chain, but before Tapedeck Post, you can easily record sketches on multiple tracks using overdubbing. Make sure both tape decks are visible by clicking on the buttons in the Toolbar.

2. Record a track in Tapedeck Post, as explained above. Send it to Tapedeck Pre by clicking on the TRANSFER button. Alternatively, load a file in Tapedeck Pre that you want to overdub.

3. Select PLAY AT OUTPUT on Tapedeck Pre.

4. Turn on SYNC DECKS on Tapedeck Post.

5. On Tapedeck Post, click on the New button to create an empty track. Click the Play button to record your second track as an overdub.

6. If you want to overdub again, click on the TRANSFER button and repeat the described procedure.

7. After overdubbing as many takes as you want, you can save your work as described above.
5.3 Tuner

The Tuner Rack Tool

Get in tune quickly and accurately! Besides simple and precise tuning, the Tuner offers presets for common tunings in a dropdown menu on its left hand side: Chromatic, Bass, Open D / E / G / A, and DADGAD tuning.

- The **CENT / STROBE** buttons switch between two tuning modes:
  - In **CENT** mode, a small indicator shows whether the pitch is sharp (right of the meter’s centre point) or flat (left of the meter’s centre point). The number left of the display indicates the number of the string being tuned. When a string is in tune, the indicator sits in the middle of the meter and turns blue.
  - In **STROBE** mode, a series of lights moves to the right when the string is sharp, and to the left when the string is flat; the faster they move the more out of tune the string. When the lights stop moving, the string is in tune.
- The **MUTE** button is especially convenient when using the tuner live.

► Click on the Arrow button to show the tuners expert panel:
  - **REFERENCE PITCH** sets the tuning reference, from A=425Hz to A=455Hz. The exact pitch is shown while you drag the knob.
  - **CENTS** shows the deviation from ideal tuning in cents.
  - **TUNE** transposes the tuning range. If you e.g. want to tune all strings a semitone lower, set drop tune to -1.
  - **TUNE FORK** produces a reference tone. To select its pitch, click on the note field to the right and drag up or down, or click on the Arrow buttons.
5.4 Metronome and Synchronization

The Metronome Rack Tool

The Metronome is not only for keeping yourself in time, but also serves as the master clock for all synchronized rack modules, such as modulation and delay effects.

If you are not in Sync mode (see below), you can set the tempo yourself several ways:

- Dial in any tempo between 20 and 400 beats per minute by clicking on the BPM display and dragging up or down, clicking on the arrows, or by double-clicking and entering the number directly.
- Click on the TAP button repeatedly. The Metronome will determine your average speed and set the BPM control accordingly. It is very convenient to assign this button to a foot controller (see section 6.2, Assigning Functions to the Rig Kontrol to see how) to actually tap the tempo.
- You can choose different time signatures using the dropdown menu besides the Signal display. The time signature determines the relation between downbeats and off beats.
- If the MUTE button is not pressed, this is reflected in the succession of sounds #1 and #2, as defined in the boxes below:
  - #1 is the sound played on downbeats and strong beat divisions.
  - #2 is the sound played on weak beats.

You can change both sounds to any .WAV file you want by clicking on the respective Load button.

The sync setting defines if the Metronome obtains its tempo setting from any other source. The three available sync settings are:

- ext: When in plug-in mode, the Metronome is synchronized to the host’s tempo, or to the external MIDI clock when in stand-alone mode. All controls for setting the tempo are disabled.
- sound: The current tempo is stored with the Rack content when you save a preset. In this setting, the Metronome loads the tempo information when you load a preset. This is useful for preparing presets with synchronized effects e.g. for a live show.
• **free**: This effectively turns host and preset synchronization off. The Metronome can run freely at the tempo you set, independent of the preset loaded or the host’s tempo. It is still setting the clock for all synchronized effects in the rack, and the current tempo is still saved with the preset!

• The **MUTE** button and the **VOLUME** knob serve to adjust the volume of the Metronome sound or to mute it.

### 5.5 Preset Volume

The Preset Volume Rack Tool

The sound of many of GUITAR RIG’s components is highly sensitive to the level of their input signal and their volume setting. This is commonly used for the sake of sound design, resulting in volume differences between presets. Therefore, you might want to adjust the overall volume of your Rack to achieve the same Output Level for different presets. This is exactly what the Preset Volume does: simply adjust the volume fader after you have found the sound you were looking for — its position is automatically saved with your preset.

• Use the **LEARN** button to automatically set the optimum Preset Volume: After clicking on it, just play loudly for a short while until the volume is automatically adjusted.

• The **PRE** Button allows you to hear Dry / Wet mixing before audio goes into the rack. In default mode mixing is done after the rack and before the Master FX.

• Use the **DRY** slider to control the volume level of the dry signal.

• Use the **MIX** crossfader to switch between the Dry signal and the Wet (affected) signal.

• Use the **WET** slider to control the volume level of the wet signal.
5.6 Master FX

The Master FX Rack Tool with Delay and Reverb preset.

Whether you want to let a long delay ring over your change of presets, add a global EQ to all of your presets, or just stick to your FX chain while changing amp presets: Master FX is what you need.

The Master FX holds components that process the sound after going through the “core” Rack. The main difference is that the content of this section remains unchanged when you load another Rack Preset.

Using this section should feel very natural if you look at it as a Rack within the Rack:
- Add components from the Components Pool or the Rack with drag and drop. The orange line indicating the destination must be below the Master FX header.
- Delete, move or quickly replace components within the grey outlined Master FX area.
- Configure your Master FX chain from factory or user presets.
- Click on the x (cross) to empty the whole Master FX section.
- Click on the arrow to minimize the Master FX section.
Master FX Presets
You can store any chain of components in a Component Preset for the Master FX. This works just the same as with any regular component: Click on the arrow of the black Component
Preset Display to open the pull down menu, and select Save As. Master FX Presets are stored in the Tools section of the Component Pool.
New Banks may also be created similarly to other Component Presets.
Just as the other Rack Tools, the Master FX can’t be selected or highlighted.
6 The Rig Kontrol

This section is about the integration of GUITAR RIG with the Rig Kontrol pedalboard — if this does not concern you, you can skip it. To learn how to assign your MIDI controller to the Virtual Rig Kontrol, refer to section 8.1.3, Linking External MIDI Controllers to the Virtual Rig Kontrol.

The Rig Kontrol is a fully integrated hardware solution for using and controlling GUITAR RIG 5. Nine freely assignable switches and an expression pedal are at your disposal right after connecting it. Note that you can use the Rig Kontrol to control GUITAR RIG 5, even if you do not use it as your audio interface. For detailed information about the hardware and how to use the integrated audio interface, refer to the Hardware Reference.

Before you continue, make sure that your Rig Kontrol is connected via USB 2.0 and activate the Virtual Rig Kontrol by clicking on its button in the Toolbar. On the Virtual Rig Kontrol, each button is headed with an LED indicating its status (on/off). The LED bar left of the foot pedal shows the degree to which it is pressed down. The Virtual Rig Kontrol provides an expert panel to manage and configure assignments, e.g. to set the range of each controlled parameter.

6.1 Activating the Rig Kontrol

The RIG KONTROL is automatically activated in GUITAR RIG the moment it is plugged in. When running multiple instances of GUITAR RIG (for example as a plug-in), the last one launched is controlled by the RIG KONTROL by default.
Bring up the Virtual Rig Kontrol by clicking on its button in the Toolbar or by pressing F3. Clicking on the Active LED activates the RIG KONTROL.

### 6.2 Assigning Functions to the Rig Kontrol

The labels below the buttons and left of the foot pedal show which function is currently assigned to them. The switches of the RIG KONTROL are best suited for controlling Bypass or Mute controls, whereas the pedal is perfect for the wah-wah, sliders or volume knobs.

**Drag and Drop**

Assigning functions is easy with drag and drop:

1. Click on one of the Rig Kontrol labels and drag it onto a controller in the Rack to assign the function.

2. If you operate a switch or the pedal of the (physical) RIG KONTROL, both the Virtual Rig Kontrol and the assigned function will react to it.

![Rig Kontrol Interface](image)

The label of Switch 1 is dragged onto the Volume I knob of the Plex.
While dragging, the mouse pointer gives you feedback as to where you can create an assignment by showing a small arrow. A No Entry sign is shown at areas where dropping the item is not possible.

**Context Menu**

Alternatively, you can use the context menu to browse through all assignable functions: just right-click on the label of the switch you want to assign to call it up.

The context menu also offers to remove all of the assignments of a particular control with one click on Clear All.

Most importantly, you can choose to *Lock* this control's current assignments, protecting them from being altered when changing Rack Presets - until you unlock them, again using the context menu. The global status of any controller is indicated by the padlock symbol.

### 6.3 Configuring Assignments

The RIG KONTROL's assignments can be managed in the expert panel of the Virtual Rig Kontrol. Click on the arrow button to reveal the assignment, then click on a label or switch on the Virtual Rig Kontrol to select it. The functions assigned to this particular control are now shown in the expert panel.
Virtual Rig Kontrol Expert Panel

Here is what the expert panel can do for you:

- Assigning functions by dragging and dropping the white label in the upper-left corner.
- To change the display name for the selected control, change the text in the black field on top of the expert panel. This is — regardless of the text in the white label — what is shown on the Virtual Rig Kontrol.
- There are two pages with 4 assignment slots each. If you are using more than 4 assignments, click on the button labelled 5-8 to show them.
- To temporarily deactivate an assignment, click on the tick mark on its left-hand side. Click again to reactivate it.
- To delete an assignment, click on the x (Cross) on its right-hand side. To delete all assignments for a particular controller, right-click on its label and select Clear All.

**Mapped Range of Parameters**

There is a horizontal line representing the value range of each assignment. To adjust the way the controller’s input values are mapped to the assigned parameter, you can click and drag the brackets left and right of the line.

- The left bracket defines the value mapped to the controller at zero; the right bracket defines the value mapped to the controller at maximum.
• As switches are always either on or off, the brackets can be used to define the triggered knob positions. Thus, you can configure a knob to switch between 12 o’clock and full gain for a volume or intensity boost.
• Because you can drag the brackets across to either end, the mapping can be inverted so that the assigned knob will be turned down when you push the switch, instead of up. This is useful if you want to assign two different value changes to one control, e.g. increasing gain while turning master volume down.

6.4 Assigning Functions to External Controllers
You can connect external footswitches or pedals to your RIG KONTROL’s analogue controller inputs and easily assign them using the Virtual Rig Kontrol. Please make sure the inputs are correctly configured in the Preferences pane (see section 8.2, Preferences) first.
Activate the expert panel of the Virtual Rig Kontrol by clicking on the arrow button. In the upper right corner there are two labels representing your analogue controllers, and they behave exactly like the Rig Kontrol labels. The assignment of functions works the same as with the internal controls of the RIG KONTROL:
1. Click on the arrow button on the Virtual Rig Kontrol to show its expert panel.
2. Drag the Pedal 1 or Pedal 2 button onto any function in the Rack.

If the external footswitch you are using is “on” only while pressed (instead of switching between “on” and “off”), activate Toggle mode in the context menu of the according input.
7 Using Guitar Rig in a Host

GUITAR RIG 5 works within all digital audio workstations (DAWs) that support the VST, RTAS or AU plug-in interface. The plug-in is automatically installed.

7.1 Basics
After installation, you can instantly use GUITAR RIG 5 in your host just like any other plug-in. The plug-in and the stand-alone version of GUITAR RIG 5 share the same presets and settings — any changes you make in one will naturally affect the other!

7.1.1 Audio and MIDI Setup
In plug-in mode, the audio interface is controlled by the host application, so the Audio and MIDI settings of GUITAR RIG are not effective. Please consult the documentation of your DAW on how to set up audio and MIDI. Remember to avoid zero-latency and direct monitoring options, as you won’t hear your guitar processed by GUITAR RIG 5 if these are turned on.

7.1.2 Plug-In Location
During the installation of GUITAR RIG 5 on a Windows computer, you need to specify the folder where your DAW looks for VST plug-ins. This is where the plug-in file “GUITAR RIG 5.dll” has been copied — you can move it anytime, in case you changed your plug-in folder or made a mistake. It might be necessary to re-scan the plug-in folder in your DAW before GUITAR RIG 5 appears in the list.
In Mac OS X, plug-ins are centrally stored in the Library under Audio/Plug-Ins.

7.1.3 Setting Up a Guitar or Bass Track
To setup a track to be processed by GUITAR RIG 5, just create an audio track and insert GUITAR RIG 5 as an effect. The audio track will hold the bare, unprocessed signal and your sound will be routed through GUITAR RIG before reaching the output stage of your DAW. Thus, you can easily tweak the sound of your guitar or bass tracks after recording (re-amping) and even automate the parameters of your sound as a part of your arrangement (see section 4.3, Component Presets).
Attention: Although some programs allow you to plug in GUITAR RIG 5 as a MIDI instrument (because it works both with audio and MIDI), you should use it as a signal processing / effects insert.

### 7.1.4 Synchronization
If you want GUITAR RIG 5 to be in time with your host, remember to turn on Ext mode in the Metronome (see section §5.4, Metronome and Synchronization). This will turn off the speed setting of GUITAR RIG and use the host’s tempo as a master. This affects all synchronized effects and the modifiers, as well as the Metronome itself.

### 7.1.5 Total Recall
When using GUITAR RIG 5 within a DAW it will save whatever is the current state of GUITAR RIG 5. So, if you are using a modified preset (as compared to how it is stored), don’t worry — when you next load the project, the rack will be recalled exactly as you left it.

### 7.2 Automating Parameters
This section is intended to give a mere introduction to automation and the characteristics of GUITAR RIG 5. As this is a sequencer subject, please refer to your DAW’s documentation to learn how it works with your particular software.

Automation in a sequencer means recording parameter changes: the movements of your wah-wah pedal, or switching of the bypass of the fuzz right before the solo! This can be done immediately while you play, e.g. with a foot pedal, or in a separate step afterwards.

Automating parameters is very easy when you use GUITAR RIG 5 as a plug-in! Whether you set up your controller hardware in GUITAR RIG or in your host, or if you want to use your mouse to control parameters, any way to move the knobs in GUITAR RIG is a way to record automation!

#### 7.2.1 The Automation List
Please refer to your DAW’s documentation to learn how to show the Automation List for the track where the GUITAR RIG 5 plug-in is inserted. All parameters of components that are currently in your Rack are automatically present in the Automation List, so they can be addressed by track automation in your sequencer. Check the context menu of any knob to see its current automation ID!

- The automation list offers 512 slots, divided into three areas of application:
- The first 256 slots are reserved for component parameters of the main rack.
- Slots 257-383 are statically assigned and reserved to Rack Tools and Framework Parameters (such as Preset Volume).
- Slots beyond 384 are dynamically assigned to component parameters used in the Master FX section.

Deleting a module from the rack results in clearing of the slots it had occupied before. When you add a new one, it tries to fit its parameters into the empty spaces within the current Automation List. Only if this is not possible, entries will be appended at the end of the list.

**Enabling Automation for Rack Tools**

The Rack Tools (Metronome, Tapedecks, etc.) are by default set to automation with static automation IDs. However, there is an option to switch any Rack Tool back to dynamically assigned automation IDs, in order to maintain backwards compatibility.

To switch between the automation modes:
Right-click a Rack Tool and select *Enable Static Automation IDs* or *Disable Static Automation IDs* (whichever mode you’d like to activate).

**Rebuilding the Automation List**

After you have added and removed numerous components, your Automation List can be a bit of a mess. If you want to fill up all the empty spaces, right-click any component of your Rack (while in plug-in mode) and select *Rebuild Automation List* from the context menu. Mind that all your previously recorded automation might be assigned to a wrong component now, as a result of their changing positions in the Automation List.

### 7.2.2 Automating Parameters in Apple Logic Pro

This example explains how to work with Apple Logic Pro, but all other DAW software operates in a similar fashion. Please refer to the documentation for your DAW for more information on the specifics of your host.

1. In the View menu, turn on track automation for the selected track, so you can see what you are doing.
2. Change the track to Latch or Touch mode
3. Start playback.
4. Move the desired control(s) of GUITAR RIG using the RIG KONTROL, any MIDI controller or your mouse.

The automation will be recorded automatically as you play back the track. Of course, you can also use the pencil tool to draw automation by hand!

### 7.3 Sidechaining

There is a new feature in GUITAR RIG 5 that deserves an introduction: the Sidechaining function allows the use of an additional signal (other than the one actually processed) to control parameters of an effect, e.g., for triggering compression rates of a compressor. Originally developed so that radio DJs could speak over music (the incoming voice would limit or compress the volume of the music) sidechaining has now become a favorite tool for studio engineers and producers.

In GUITAR RIG 5, a Sidechaining control is available in the Envelope, LFO, Input Level in the Modifier section and in the Stomp Compressor, Tube Compressor, and in the all new Fast Comp from the DYNAMICS section. Using the Modifiers together with Sidechaining allows for new possibilities in sound design that go far beyond the often used Sidechain compression trick. Please refer to your DAWs manual on how to use Sidechaining in your favorite host. Of course, Sidechaining can also be used in stand-alone mode, but its more obvious usage comes in the context of a DAW setting. To use Sidechaining in stand-alone mode, you need to configure GUITAR RIG's additional Sidechain inputs in the Audio and MIDI Settings dialog.
8 Options

The Options tab provides access to two areas: Controller assignments and general Preferences for configuring the application.

8.1 Controller

The dialog for managing controller assignments

This page lets you set up and manage your external MIDI controller assignments. Before you continue, please make sure that your MIDI interface is activated in the Audio and MIDI settings (see section 10, Audio and MIDI Settings). Also check if the correct MIDI channel is selected on the Preferences tab (see section 8.2, Preferences). Note that GUITAR RIG 5 reacts to MIDI Program Change messages regardless of assignments: They switch presets within the current Preset List.

Controller Assignment the Easy Way

The quickest way to control any knob with a MIDI device is provided by its context menu:
1. Right-click on the knob or fader you want to control.

2. Select Learn.

3. Operate the external controller. It is instantly linked to the parameter. A message will appear informing you that a new controller has been added — GUITAR RIG makes no difference between keyboard shortcuts and MIDI messages! Note that you can also clear all assigned controllers using the same context menu.

### 8.1.1 Setting up External MIDI Controllers

Each of your device’s controls (knobs, fader, etc.) can be configured via the Controller list. You only need to do this once, as the Controller list is global for all presets. Make sure you are on the Controller tab of the Options page in the SideKick. Follow these steps to add a new MIDI controller:

1. Click on the Add Controller button on the bottom of the SideKick to add a new controller entry. Rename it by double-clicking on the white headline bar.

2. To link a (physical) device to the controller entry, click on the Learn button and operate the knob (fader, etc.) you want to link briefly. Its MIDI code will be shown in the box right of the button and the Learn button will pop out. It is also possible to assign keyboard shortcuts the same way!

If you want to change the device a controller is linked to, just click Learn again and operate the desired knob.

Important: If the MIDI footswitch you are using is sending “on” only while it is pressed (instead of switching between “on” and “off” each time you press it), this will be the behavior of the assigned parameter as well. If you want to change it, activate Toggle Mode in the Menu of the according controller.
Deleting Controllers

To delete any entry of the Controller list, first select it by clicking once — an orange frame highlights the entry. Then click on the Delete Controller button on the bottom of the SideKick.

8.1.2 Assigning Functions to Controllers

Each controller input can trigger different functions in GUITAR RIG at once. Its assignments are shown below the Controller list entry, each in a separate line.

1. To assign a function of GUITAR RIG to the controller, drag its white headline bar onto the element (knob, button, fader, etc.) of the Rack that you want to control.

2. While dragging, the mouse pointer gives you feedback as to where you can create an assignment by showing a small arrow. A No Entry sign is shown where elements cannot be assigned.

3. The function you just assigned is now listed below the according entry in the Controller list. More assignments can be added the same way.

Assigning controllers

Configuring and Deleting Assignments

- To temporarily deactivate an assignment, click on the tick mark on its left-hand side.
- To delete an assignment, click on the x (Cross) on its right-hand side.
- To delete all assignments for a particular controller, click on the Menu button and select Clear All.
- To adjust the way the controller’s input values are mapped to the assigned function, you can click and drag the Brackets left and right of the horizontal line.
- The left bracket defines the value mapped to the controller at minimum (MIDI value 0), the right one the value mapped to the controller at maximum (MIDI value 127).
- As switches are either on or off, the brackets can be used to define the difference between the actual knob positions they trigger.
- The mapping can be inverted by pulling the left bracket over the right, or vice versa, so that the assigned knob will be turned up when the controller goes down.

**Assigning Functions via Menu**

Drag and drop is not the only way for creating controller assignments, the **Menu** button offers an alternative, listing all available functions in a menu-like interface. Click on the **Menu** button and navigate through the categories and click on any function to create an assignment.

![The Controller menu](image)

Even if you prefer drag and drop, the menu is necessary to assign functions that are not controlled by any rack module, e.g., switching presets.
Global Assignments
By default, all assignments are stored on the preset level, so they change as the preset changes. In most cases this is the expected behavior, but you may wish to have some global assignments that are always the same. The most obvious and common case is when you assign Sound Selection — Previous / Next to a controller to step through the presets.
To make any controller’s assignments global (overriding assignments on preset level), click on the according Menu button and select Lock (a padlock symbol appears).

Unlocking the controller

Unlock the controller the same way to be able to add or delete assignments.

8.1.3 Linking External MIDI Controllers to the Virtual Rig Kontrol
The Virtual Rig Kontrol is a perfectly integrated component of GUITAR RIG 5, sporting pre-assigned functions for many presets and a convenient display for all its assignments, especially in Live view. If your external MIDI controller features a comparable set of controls, it can make sense to map it to the Virtual Rig Kontrol and then use the latter for assigning functions instead.
Linking its knobs and the pedal to any controller input works exactly the same as with other functions: Just drag the controller and drop it onto the button of the Virtual Rig Kontrol you want it to be linked with. All the functions assigned to this particular button will now be triggered by the linked controller input. Assigning functions to the Virtual Rig Kontrol works by dragging the box below or beneath each of its controls (containing its name) onto the desired knob or switch in the rack. See section 16.2, Assigning Functions to the Rig Kontrol to learn more!

8.1.4 Hold Mode for MIDI Controllers and Rig Kontrol
There are generally two ways a switch can behave:
- The more common type switches between the “on” and “off” state each time it is operated.
- The other type is a “momentary” switch. It remains in the “on” state only as long as the switch is depressed, and returns to “off” as soon as it is released. This can be very useful when triggering effects.

In GUITAR RIG 5, each controller input can be set to work in “Hold mode” via its context menu to reflect this difference. Just right-click any label of the Virtual Rig Kontrol, or click on Menu in any entry of the MIDI Controller list to call it up.

Disabling Hold mode for a MIDI Controller

Enabling Hold mode for Virtual Rig Kontrol

Hold mode acts differently depending on the hardware connected:
- Per default, the Rig Kontrol switches toggle “on” and “off” each time they are operated. Enabling Hold mode will turn them into momentary switches.
- Most common switches on a MIDI controller should work just as Rig Kontrol switches. However, if you find them behaving weirdly — i.e. they need to be operated two times to toggle on or off — you should try the other mode.
- Momentary switches on a MIDI controller will work as such when Hold mode is enabled. In most cases, turning off Hold mode will enable them to work in the other mode as well.

8.2 Preferences
Under the Options tab, click on Preferences to configure GUITAR RIG 5.
The Preferences Menu

It offers the following settings:

- **Window Height**: Use this control to set the height of the GUITAR RIG 5 window. You can choose among Small, Medium or Large. The actual dimensions in pixels (given in brackets) depend on the physical display resolution of your monitor.

- **MIDI Channel**: Set the channel on which GUITAR RIG listens for incoming MIDI messages. Choose *Omní* if you want it to listen on all channels.
- **MIDI Learn Popup Window**: Toggles whether or not the MIDI Learn Window will pop up after each MIDI assignment you make.
- **Show Help Hints**: Toggles whether hints appear when the mouse is hovering over control elements.
- **Scan For New Presets**: Updates the preset database. Use if you copied files to the preset folder manually or created new presets using Kore2.
- **Import Guitar Rig 4 User Rack Presets**: Select to batch import user content of an existing GUITAR RIG 4 installation.
- **Virtual Rig Kontrol Style**: You can adapt the appearance of the Virtual Rig Kontrol, if you are using the silver Rig Kontrol 2.
- **Rig Kontrol 1**: Turn on to activate compatibility mode for the blue Rig Kontrol 1.
- **Rig Kontrol Pedal Parameter Mode**: Controls with which value the pedal and its assigned parameters are initiated when a preset is loaded: The actual current position the pedal is in (Pedal mode) or the one stored with the preset (Preset mode).
- **Rig Kontrol Pedal Calibration**: If your RIG KONTROL pedal does not behave as intended, click Reset, and follow the instructions to recalibrate it.
- **Rig Kontrol Ext. Pedals Calibration**: If the external pedals connected to your RIG KONTROL do not behave as intended, click Reset, and follow the instructions to recalibrate them.
- **Rig Kontrol 3 Ext. Pedal 1/2 Mode**: Use this menu to adjust the Rig Kontrol to different types of external pedals or footswitches. Please refer to the documentation of your pedal / footswitch to find out the correct setting. If it doesn’t work, just try out the other setting.

### 8.2.1 Rig Kontrol 1 Support

The earliest Rig Kontrol can still be used for controlling GUITAR RIG 5, with the natural limitation of having only one audio input channel, of course. The second channel transmits the unit’s control signal and is therefore not available. To activate Rig Kontrol 1 compatibility, go to the Options pane in the SideKick and select Preferences.

1. In the line labeled Rig Kontrol 1, click on the dropdown menu.
2. Select the channel your Rig Kontrol is sending the control signal on (Left or Right).

The according channel button in the Global Header turns blue to indicate that the Rig Kontrol 1 blocks it.
Left channel blocked by Rig Kontrol
9 Menu Bar

GUITAR RIG 5 is designed in a way that — once set up — you will hardly ever need to use the Menu bar. Most functions are easier to access another way, as explained above. However, it may be necessary to change the "Audio and MIDI settings..." in standalone mode. Also, all the GUITAR RIG 5 documentation is conveniently linked in the Help menu.

9.1 File

New Sound
Creates an empty new preset. Just enter a name, press Save and fill the Rack with your components of choice!

Save Sound
Has the same effect as clicking on Save in the Preset Browser. Saves changes to the currently loaded preset.

Save Sound As...
Has the same effect as clicking on Save as... in the Preset Browser. Saves the current rack as a new preset.

Import
Allows the import of GUITAR RIG presets into the Preset Browser. This option lets you browse for GUITAR RIG 3 Banks, and for GUITAR RIG 4 and GUITAR RIG 5 rack sounds. An easier way to import is to drag and drop the files directly into the browser preset list.

Audio and MIDI Settings...
To configure the audio and MIDI system of GUITAR RIG 5 for standalone use. See section ↑10, Audio and MIDI Settings for details.

Exit
Quits the application.
9.2 Edit

Undo
Undoes the last operation, including destructive errors like clearing the whole rack.

Redo
Redoes the last undone step.

Cut / Copy / Paste / Delete / Select All
Performs the standard edit operations in the current context: *Copy and paste* rack modules, *select all* or *delete* entries from the Preset List, and so on. The action performed depends on the currently selected area of the user interface, i.e. where you last clicked.

9.3 View

Hide/Show Hints
Has the same effect as the according option in *Preferences*. Disables or enables the helpful hints shown when the mouse is hovering over control elements.

Full Screen
Activates full screen mode, giving you the maximum possible resolution - extremely useful in Live view. Press ESC or F4 to return to normal mode.

Hide/Show SideKick
Hides or shows the left area of the GUITAR RIG 5 user interface, where Preset Browser, Components Browser and Options are displayed.

Hide/Show Live View
Has the same effect as clicking on the *LIVE* button. Activates or deactivates Live View.
Hide/Show Rig Kontrol
Has the same effect as clicking on the Virtual Rig Kontrol button. Hides or shows the Virtual Rig Kontrol.

9.4 Help

Launch Service Center...
Starts the Native Instruments Service Center — for activating the application and downloading updates. Read the Setup Guide for more information!

Activate GUITAR RIG 5...
Starts the Native Instruments Service Center, directly taking you to the Activation tab.

Open Manual...
For access to all available manuals, navigate to your language.

Visit GUITAR RIG 5 on the Web...
Your permanent bookmark to the GUITAR RIG 5 website, where you find product-related resources, news and entertaining extras!

Visit the Knowledge Base...
Another extremely useful bookmark leads to the Knowledge Base, your primary source for troubleshooting and sharing technical experiences with GUITAR RIG 5.

About GUITAR RIG 5
Brings up the About-Screen, giving information about the software version, your registration number and the creators of GUITAR RIG 5.
10  Audio and MIDI Settings

This section explains how to configure GUITAR RIG’s Audio and MIDI Settings.

10.1  Audio

The Audio and MIDI Settings dialog.

**Driver**
Choose the correct type of driver for your audio interface. Using ASIO (Windows) / CoreAudio (Mac OS X) is strongly recommended.

**Device**
Select your audio device from the list. If it doesn’t appear, check if it is connected and its drivers are properly installed.
Status
Shows the current status of the selected audio interface, which should be Running. If it says Stopped, please consult the documentation of your audio interface. Check if it is connected and if its drivers are properly installed.

Sample Rate
Choose the desired sample rate for audio processing, the standard is 44100 Hz. Higher sample rates may result in higher quality, but they definitely consume more CPU power.

Latency
Latency is the time that passes between the moment you hit a note and the moment you hear it. It is caused by several stages of data transfer and audio processing, all of which consume a small amount of time. The latency allowed for processing can be adjusted within a certain range, but the lower you go, the higher the probability of processing errors gets. Everything depends on your computer’s processing power and the quality of your audio drivers! It is strongly recommended to consult the documentation of your audio interface to learn more.
► For a Windows Computer, click on the ASIO Config button to change the latency. Your audio driver’s setup window will be called up.
► On a Mac OS X, latency is set directly in the Audio and MIDI settings. Use the Latency slider to try out how low you can go. Play while you are moving it, and watch out for crackles, pops and dropouts. If they occur, your latency is set too low.
The latency value is given in samples, its time value can be calculated easily: Divide the number of samples by the sample rate (samples/s) and you get the processing latency in seconds. The three major stages of latency are calculated in the Audio and MIDI settings... window automatically, as well as the resulting overall latency in milliseconds.

Note that this value might be higher than what you’re used to, because often, you are only given the internal buffer size in ms, instead of the real overall latency.

Routing
If you want to invert the Input or Output channels, set up a special routing for multi-channel setups, or use the new SideChain function, this is the place to go. The left column shows the available channels of your audio interface. The entries in the right column are
actual menus. By clicking on them, you can assign the left and right channels of GUITAR RIG 5 to any of your audio interfaces channels. This is done separately for Input and Output. Be careful, as a misconfiguration of the Routing table may lead to not hearing any output!

**MIDI**

The left column shows all available MIDI devices, sorted by Input and Output. The entries in the right column are actually menus. By clicking on them, you can turn them on or off. Mind that any devices you want to use to control GUITAR RIG 5 have to be activated (turned On) under Input.
# 11 Keyboard Shortcuts

Find below a list of keyboard shortcuts for use with GUITAR RIG. These provide shortcuts from system basics to switching between different views. With keyboard shortcuts, you can quickly perform tasks on your computer by pressing keys on your keyboard instead of using a mouse.

If you're working on a portable computer, you must press the Fn key before pressing the other keys of a shortcut; for example, press Fn-Control-F1.

<table>
<thead>
<tr>
<th>Type</th>
<th>Command</th>
<th>Windows</th>
<th>Mac OS X</th>
</tr>
</thead>
<tbody>
<tr>
<td>File</td>
<td>New Preset</td>
<td>[Ctrl]+[N]</td>
<td>[Cmd]+[N]</td>
</tr>
<tr>
<td>File</td>
<td>Save Preset</td>
<td>[Ctrl]+[S]</td>
<td>[Cmd]+[S]</td>
</tr>
<tr>
<td>File</td>
<td>Save As Preset</td>
<td>[Ctrl]+[Shift]+[S]</td>
<td>[Cmd]+[Shift]+[S]</td>
</tr>
<tr>
<td>File</td>
<td>Quit</td>
<td>[Alt]+[F4]</td>
<td>[Cmd]+[Q]</td>
</tr>
<tr>
<td>Edit</td>
<td>Undo</td>
<td>[Ctrl]+[Z]</td>
<td>[Cmd]+[Z]</td>
</tr>
<tr>
<td>Edit</td>
<td>Redo</td>
<td>[Ctrl]+[Y]</td>
<td>[Cmd]+[Shift]+[Z]</td>
</tr>
<tr>
<td>Edit</td>
<td>Cut</td>
<td>[Ctrl]+[X]</td>
<td>[Cmd]+[X]</td>
</tr>
<tr>
<td>Edit</td>
<td>Copy</td>
<td>[Ctrl]+[C]</td>
<td>[Cmd]+[C]</td>
</tr>
<tr>
<td>Edit</td>
<td>Paste</td>
<td>[Ctrl]+[V]</td>
<td>[Cmd]+[V]</td>
</tr>
<tr>
<td>Edit</td>
<td>Delete</td>
<td>[Del]</td>
<td>[Delete]</td>
</tr>
<tr>
<td>Edit</td>
<td>Select All</td>
<td>[Ctrl]+[A]</td>
<td>[Cmd]+[A]</td>
</tr>
<tr>
<td>View</td>
<td>Hide/Show Hints</td>
<td>[Ctrl]+[I]</td>
<td>[Cmd]+[I]</td>
</tr>
<tr>
<td>View</td>
<td>Full Screen</td>
<td>[F4]</td>
<td>[F4]</td>
</tr>
<tr>
<td>View</td>
<td>Hide/Show RigKontrol</td>
<td>[F3]</td>
<td>[F3]</td>
</tr>
<tr>
<td>View</td>
<td>Hide/Show SideKick</td>
<td>[F2]</td>
<td>[F2]</td>
</tr>
<tr>
<td>View</td>
<td>Hide/Show Live View</td>
<td>[F1]</td>
<td>[F1]</td>
</tr>
</tbody>
</table>